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TIPS: 1. Use your spreadsheet's search facility to locate keywords within this guide.
2. The guide is pre-formatted to print over several pages using your spreadsheet's print function.
Users of the Premium version should do this via the *Help menu.
3. If using a spreadsheet other than Excel and this guide doesn't format correctly, a PDF version can
be downloaded from <www.planware.org/cashhome.htm>.

Very Quick Start
1. Populate all relevant cells in the "Setup" sheet. You can update entries at any time.
2. Base assumptions on the 'most likely' scenario for cash receipts and payments.
3. Enter income projections into the "Incomes" sheet within the cream, boxed-in areas.
4. Enter expenditure forecasts into the "Expend" sheet. Start with the biggest items and then
sytematically add greater detail.
5. In "Bank" enter credit card transaction assumptions and specify interest payment months.
6. Review results and iron out possible problems Try running 'what-ifs' and 5-Year projections.
DO: Save your work regularly with incrementing file names e.g. PLAN1, PLAN2 etc.
DO NOT: Delete unneeded rows or change any formulae.
We appreciate that no one likes reading manuals. While Cashflow Plan is easy to use, a quick skim
through this guide may prove useful and save you time in the long run.

1. What's Cashflow Plan Home?
Happiness is a positive cash flow (Fred Adler)

Cashflow Plan Home is a powerful, easy-to-use Excel-based file which helps individuals and households prepare 12-month
cashflow projections for the purpose of planning and managing their finances. It also contains tools for doing 'what-ifs',
generating 'high-level' 5-year projections and (in the Premium version) rolling projections foward on a monthly basis.
Cashflow Plan has been developed by PlanWare, an established producer of business planning and financial projection
tools.
Cashflow Plan will save you lots of time by simplifying the task of constructing and managing your personal or household
budget. It could also save you cash by providing a clear view of your likely monthly finances. This will help you optimise
future income/ expenditure and handle projected cash surpluses or shortfalls arising over the coming 12 months. See
"Improving Your Cashflow" below.
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No prior experience of spreadsheeting or household budgeting is required as Cashflow Plan is preformatted to handle all
common income and expenditure items encountered when preparing a household budget. However, if you are a spreadsheet
user you can easily adapt Cashflow Plan to meet specific needs - see "Changing Cashflow Plan Home" below.
Based on your assumptions, Cashflow Plan projects cash in- and outflows for a year ahead on a monthly basis. In doing so,
it handles movements in current/checking, savings and credit card accounts; automatically calculates interest; and projects
monthly balances for these accounts. Advisory messages are given when credit limits etc. are exceeded. A built-in 'what-if'
facility can be used to quickly explore alternative scenarios and outcomes. Cashflow Plan also includes a tool for generating
'high-level' projections for 5 years ahead and, optionally, it also handles monthly projections for a home-based business.
Cashflow Plan is preformatted to accommodate about 170 income and expenditure variables for a household, individual and
home-based business and uses over 3,000 formulae. It contains eight charts which graph dozens of variables and nine
comprehensive reports which can be printed on paper or as PDFs (if supported by the spreadsheet being used). These cover
monthly and full-year assumptions, projections, analyses, summaries and charts.
Cashflow Plan is available in two versions as follows:
1.

A freeware version for Microsoft Excel and many other spreadsheet types which can handle Excel's XLS
files. See the FAQ at Cashflow Plan's web page at <www.planware.org/cashhome.htm> for details.

2.

A Premium version which requires any desktop version of Microsoft Excel (released after year 2000). This
restriction applies because this version of Cashflow Plan makes extensive use of Visual Basic. See
"Upgrading Cashflow Plan Home" below.

The key difference between the two versions is that the Premium version incorporates extensive menus to facilitiate the
speedy entry of assumptions, printing of reports and charts and other rountine tasks and activities. It also includes a facility
to 'roll forward' assumptions and projections on a monthly basis without having to completely re-enter assumptions.
The Premium version costs US$12 (approximately €11 euro or £9 sterling) plus any sales or value-added taxes. It can be
purchased using a credit card and immediately downloaded via <www.planware.org/cashhome.htm>.
If you are involved in a business and find Cashflow Plan's "HomeBiz" sheet too basic, you should explore PlanWare's
extensive range of Excel-based planners for start-ups, established small businsses and strategic units within larger
enterprises. The range includes:
Cashflow Plan Micro, Lite, Pro, Super & Ultra
Five versions with differing levels of detail and sophistication. Incorporating both US/Canadian and
UK/International accounting formats.
Each version generates fully-integrated financial projections for 12 months ahead along with income
statements, cashflow forecasts, balance sheets and ratio analyses for each month. They incorporate a
monthly 'roll-forward' facility for easy updating of projections. The more powerful versions contain a
tool for consolidating projections for multiple entities. Extensive manual and tutorials are included.
For businesses with annual sales in the range US$/£/€ 0.5-20.0 million. Excel running on a Windows
PC is essential. Full details and free trial version downloads at <www.planware.org/cashplan.htm>.
Exl-Plan Basic, Micro, Lite Pro, Super, Super Plus, Ultra & Ultra Plus
Eight versions are available as separate US/Canadian and UK/International editions. They generate
fully-integrated financial projections for three, five or seven years ahead.
Typically, each version produces detailed monthly projections (income statements, cashflow forecasts,
balance sheets and ratio analyses with extensive charts) for the initial 12/36 months and less detailed
quarterly or annual projections for subsequent years. Built-in tools include sensitivity analysis and
'what-ifs'. Comprehensive manual and tutorials are included.
For businesses with sales in the range US$/£/€ 0.5-20.0 million. Excel running on a Windows PC is
essential. Full details and free trial downloads at <www.planware.org/exlplan.htm>.

2. Licenses for Cashflow Plan Home
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The two most beautiful words in the English language are 'check enclosed' (Dorothy Parker)

Freeware Version
The freeware version of Cashflow Plan can be freely copied and shared with friends, work colleagues,
business associates and customers provided that attributions to PlanWare etc. on passwordprotected, locked sheets are unaltered and no fee is charged. Subject to the foregoing, a Creative
Commons Attribution-NonCommercial License <https://creativecommons.org/licenses/by-nc/4.0/>
applies.
The "Front" sheet of the freeware version includes a window to hold the name and contact details of
any organisation which wishes to distribute Cashflow Plan at no charge to clients, contacts, staff etc..
Adding specially-tailored assumption or output reports (or sheets) or translating the text in assumption
and output reports are acceptable modifications. However, changing or removing the "Front" and other
password-locked sheets are NOT acceptable.
Premium Version
The Premium version is licensed to the registered user and Cashflow Plan's XLS file and derivatives
thereof must not be copied/distributed to unregistered users. This restriction does NOT apply to
reports etc. converted into 'read only' files (e.g. PDFs) prior to circulation. See "Upgrading Cashflow
Plan Home" below.

3. Introducing Cashflow Plan Home
A bank is a place that will lend you money if you can prove that you don't need it (Bob Hope)

Before starting to use Cashflow Plan, spend a little time exploring its worksheets to get familiar with their scope and
structure. As supplied, Cashflow Plan incorporates some illustrative values (in blue) within the topmost rows of the "Incomes"
and "Expend" sheets. These should be overwritten or deleted.
If using the Premium version, take the Cashflow Plan Tour via the *Help menu and play with the extensive tools and facilities
accessible via its menus. If using Excel 2010 or higher and running macros, these menus are visible within the Developer tab
(see "HelpMacros" sheet).
Cashflow Plan comprises a series of worksheets as follows:
(a) "Setup" contains basic set-up information including names of income earners, dates, currency, opening balances
and credit limits.
(b) Four sheets ("Incomes", "Expend", "Bank" and "HomeBiz") accommodate monthly assumptions on incomes,
expenditure, bank and credit card data and (optionally) projections for a micro- or home-business. These are
referred to here as the 'assumption reports'.
(c) A further four sheets ("Plan", "Analysis", "Summary" and "Charts") contain monthly and full-year projections,
analysis, summary and charts. These are your 'output reports'.
(d) "What-If" incorporates a facility for doing 'what-ifs'.
(e) "5-Year" facilitates the creation of optional 'high level' projections using the first-year projections as a starting
point.
(f) "Roll" contains the monthly 'roll forward' facility for easy updating of projections (only included in the Premium
version).
(g) "Front", "Guide" and "HelpMacros" (in Premium version only) are informational and password protected.
Cashflow Plan is distributed as an Excel XLS file type for maximum compatibility. If desired, you can change this type to
XLSX (or XLSM if using the Premium version). See the FAQ at <www.planware.org/cashhome.htm> for details.

4. Starting to Use Cashflow Plan Home
Prediction is very difficult, especially about the future (Neils Bohr)
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To use Cashflow Plan, enter your basic information in the "Setup" sheet and then progressively enter your assumptions into
the "Incomes", "Expend", "Bank" and, if applicable, "HomeBiz" sheets. As you progress, charts and output reports will be
updated instantaneously. If key data is readily to hand you should be able to produce a plan in an hour or so. This is infinitely
quicker than having to build your own planner.
While Cashflow Plan looks ahead and isn't a historic accounting system, it may be useful to maintain a simple expenditure
diary for a short, representative period to help you improve the accuracy of assumptions (particularly for out-of-pocket
expenses).
Start by reviewing the scope and contents of the various sheets*, and especially "Income" and "Expend", so that you get a
clear appreciation as to where your assumptions will be accommodated by Cashflow Plan. If you have access to a printer, it
may be useful to print blank copies of "Income" and "Expend" as guides (if using the Premium version, you should set
Cashflow Plan to Print All Empty Rows via the *Tools/Setup menu).
* If using the Premium version, take the Cashflow Plan Tour by clicking the button on the "Front" sheet or via the
*Help menu which can be found inside the Developer tab (see "HelpMacros" sheet).
When entering assumptions, start with the large items such as salaries, mortgage etc. and progressively add in lesser
amounts based on your expectations, historic bills, receipts, bank/card statements etc. adjusted for any possible inflation and
changes in circumstances.
If living on a tight budget, be reasonably conservative when projecting values on the grounds that timings and amounts could
be less favourable than you might wish. This could become your "most likely" plan. If desired, create a copy of this plan and
adjust your assumptions to reflect either a "best" or "worst" case. Alternatively, use the "What-If" sheet to explore alternative
scenarios.
To avoid confusion, you should remove the specimen assumptions (in blue) within the Income, Expend, What-If and 5-Year
sheets.
When entering basic data in the "Setup" sheet, note the following:
1. Enter one or two Names for income earners. These names will be reproduced automatically within all reports.
2. Enter the Start Year for Cashflow Plan and set the Start Month for Cashflow Plan to the next month. For
example, if working on Cashflow Plan during February, set the start month for your projections to March rather
than any earlier in the year.
3. When specifying the Currency Denomination, only use 000 (for thousands) if your numeric values are very large
or you are very wealthy! If using 000, you must enter ALL values in ALL reports in thousands. To do this, enter
1,562 as 1.562 (note position of decimal point). If using 000, you can increase the number of decimal places
displayed in reports e.g. to show 1.562 as 1.6 (to the first decimal place) or 1.56 (to two decimal places). Note
that Cashflow Plan will use the full 1.562, not 1.5, when making calculations.
If ######'s appear instead of values, you should switch to a higher denomination (e.g. 000) or explore whether
selectively widening columns eliminates these #####'s. However, the drawback to making these formatting
changes is that printed reports may become hard to read unless you change their orientation from portrait to
landscape.
When entering opening balances for accounts, use estimated likely balances for the beginning of your start
month. You can update these at any time. Use Current Account to handle any short-term credit facility you might
have with your current (or checking) account.
Here is some guidance when starting to enter assumptions:
1. If using the Premium version of Cashflow Plan, you can automatically and speedily remove all specimen values
from assumption reports via Clear All Assumption Reports in the *Tools/Setup menu which will be found in Excel's
Add-Ins tab.
2. You must complete the 12-month projections in order to use the 'what-if', 5-Year and roll-forward features.
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3. Before you start, gather together all relevant documents covering income, expenditure and account balances and
use bank and credit card statements to help reveal past outlays. Make "best" guesses to get the plan started and
refine values when more/better data becomes available. Given that Cashflow Plan runs satisfactorily with minimal
assumptions, you could start by inserting the biggest values and adding more detail later.
4. When entering assumptions, always enter values for the specific months when the cash in- or out-flow occur. For
example, if an electricity bill is received in March but doesn't need to be paid till May, enter the amount for May.
Be sure to take account of likely increases and reductions due to inflation or changed circumstances as well as
any new items emerging in later months.
5. Only enter values within cream-coloured, boxed-in areas in sheets. These areas are unprotected whereas all
other cells contain formulae and are protected unless this is removed by a user. Variable descriptions (in left-most
columns) in blue in some sheets can be modified. For more information on changing Cashflow Plan, see
"Extending Cashflow Plan Home" below.
6. Descriptions and values shown in black should not be changed or overwritten unless you have a good
understanding of Cashflow Plan and have backed up the original Cashflow Plan file. See "Extending Cashflow
Plan Home" for further details.
7. In the "Bank" sheet you can estimate how much of your projected monthly expenditure will be paid for using credit
cards and specify how and when monthly card balances are cleared. If you always pay credit card debts when
due, you can enter a simple formula in the row for Payments to card account(s) to automate this. If payments are
deferred, interest (based on monthly rate specified in "Setup") will be automatically added to outstanding monthly
balances. Experiment!
8. Lodgements to savings accounts and, if applicable, cash injections into a home business are treated as cash
outflows in the "Expend" sheet. Cash transfers from your savings account and/or home business are recorded as
cash inflows in the "Incomes" sheet.
9. You can enter or change assumptions at any stage and immediately see the impact in charts or reports. Once
Cashflow Plan has been completed, you can (1) use the 'what-if' facility to explore alternative scenarios, for
example, 'best" or 'worst' cases without having to change your detailed assumptions and/or (2) save alternative
scenarios in different files.
10 Cashflow Plan's assumption reports make no specific provisions for adding contingency amounts to cover
unplanable income or expenditure. These can be provided for by using unassigned rows within assumption
reports or by using the 'what-if' facility. Care should be taken to ensure contingency amounts are not duplicated
for individual items and globally e.g adding contingency amounts on top of contingency amounts.
11. Save your file regularly with an incementing file name, for example, PLAN1, PLAN2, PLAN3 etc. in case data is
lost or a serious error is made.
Some additional tips and tricks when using Cashflow Plan:
1. Feel free to hide rows which are not relevant to your circumstances but do NOT DELETE any rows. See
"Extending Cashflow Plan Home" below. Note that with the Premium version you can ask Cashflow Plan to
automatically hide empty rows while printing reports.
2. As supplied, Excel's sheet headings and the formula bar are hidden. These settings can be changed using your
spreadsheet menus or, in the case of the Premium version, via the *Tools/Setup menu.
3. As an alternative to printing reports, you can change your spreadsheet's print settings to generate PDF versions
of reports for easy circulation. You can also change the orientation of printed reports from portrait to landscape to
make for easier viewing.
4. In certain charts and output reports, expense categories have been combined as follows:
Summary Categories
Household & related

Expense Categories
Household, energy, insurances, accommodation and major expenditures
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Motor vehicles

Motor vehicles #1 and #2

Education & Medical

Education & Medical

Lesiure & Comms

Leisure & communications

Work, travel and pers exs

Reimburseable work exs, other travel & transport and miscellaneous exs.

Financial, tax etc.

Financial charges/payments, taxation & investment/savings

5. Cashflow Plan automatically calculates interest based on the rates specifiied in the "Setup" sheet as follows:
Interest Type

Current account

Calculation Method
Interest is calculated monthly based on (a) the annual rate specified in "Setup" and (b) the
average of previous month's opening and closing negative balances. Interest is accumulated
each month and only charged to the account when a "1" has been inserted in the row for
Interest payment months in "Bank". In the case of an overdraft, it would be normal to enter a
"1" for every month.

Savings account

Interest is calculated monthly based on (a) the annual rate specified in "Setup" and (b) the
average of previous month's opening and closing balances. Interest is accumulated each
month and only added to the account when a "1" has been entered in the row for Interest
payment months in "Bank". This could be set to happen monthly, quarterly or annually.

Credit card

Interest is calculated monthly based on (a) the monthly rate specified in "Setup" sheet and (b)
outstanding opening balance less any payment made during month to card company. If each
month's opening balance is fully cleared in that month no interest is charged. No provision is
included to cover any higher interest charged on cash withdrawals.

6. To get a detailed understanding as to how any particular aspect of Cashflow Plan processes assumptions, a
simple approach is to load up a copy and remove all its assumption values. Next, populate it with rounded but
typical asssumption values, like 1000. Then experiment with changing these values and observing the results.
7. The "HomeBiz" sheet will suit a micro-business or sole trader.When using it, keep business and personal
incomes, expenditures and bank accounts entirely separate - use the row Cash transfers to household to pay
projected wages into the "Incomes" sheet. Enter all assumptions based on actual cash receipts and payments
rather than on invoicing dates.
8. Before making 'what-if' projections, you should finalise your monthly plan. Then, at the 'What-If' sheet, use the
%+/- column to enter percentage increases or reductions for key items in your original projections. You can also
use the adjacent +/- column to make absolute increases or reductions. Experiment!
9. Before making high-level 5-Year projections, you should finalise your monthly plan. At the "5-Year" sheet, enter
values in the uprotected four columns to increase/decrease the first-year totals in the subsequent four years. Note
that annual changes are cumulative. Experiment!
10. Cashflow Plan's powerful 'roll-forward' facility can be used to greatly simplify updating of monthly projections. This
is available at the "Roll" sheet within the Premium version and requires Excel running on a PC or Mac.
Note: Cashflow Plan contains a hidden sheet called "WorkCalc" which is mainly used for interest and balance calculations
and charting data. Whilst this sheet can be unhidden to secure a greater understanding about certain calculations and
formulae, it should not be modified by users. To view it using a recent version of Excel, unprotect any sheet e.g. "Incomes",
click Home tab, click Format within Cells section and select Hide & Unhide.

5. Using the Premium Version
It's not the plan that is important, it's the planning (Dr Graeme Edwards)

CRITICALLY
IMPORTANT:

The Premium version of Cashflow Plan can only be used with a desktop version of Microsoft
Excel. It CANNOT be used with Open Office, Google Docs or similar PC-based or cloud-based
spreadsheet packages.
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The Premium version contains extensive macros (programming code) for Excel which must be enabled during initial loading
as per instructions in the "HelpMacros" sheet. This process loads nine additional menus into Excel each containing dozens
of options for quickly entering assumptions, changing protection, selecting and moving between reports, printing
reports/charts etc.
These menus all start with asterics (*) for easy identification e.g. *Assumptions, *Protection etc. To locate them, consult the
"HelpMacros" sheet or simply look inside Excel's Add-Ins tab. We recommend that you explore these menus before starting
to use Cashflow Plan and that you take the Cashflow Plan Tour (via *Help) to become familiar with the location and contents
of reports etc.
Cashflow Plan's roll-forward facilty is contained in the "Roll" sheet. It speeds up the task of updating projections and works by
shifting dates and all related assumption values forward a month at a time. If a plan starts in January and ends in December,
a roll-forward drops January and its related assumptions so that February with its original assumptions becomes the new 1st
month. March becomes the new 2nd month and so on for the other months. In addition, a new 12th month is inserted for
January of the following year using the assumptions for the original 12th month (December). Further details are contained in
the "Roll" sheet. Make a backup file and experiment!

6. Error Messages
We always plan too much and always think too little (Joseph Schumper)

Cashflow Plan incorporates basic error trapping and error messages are displayed in red across the top and/or bottom of
reports.
Overdraft limit exceeded
The limit specified in "Setup" sheet has been exceeded in one or more months.
Either raise limit, modify income and/or expenditure or temporarily ignore
message.
Credit card limit exceeded
The limit specified in "Setup" sheet has been exceeded in one or more months.
Either raise limit, increase card payments and/or reduce purchases or
temporarily ignore message.
Fix negative savings a/c balance Too much cash has been transferred out of a savings account in one or more
months. Reduce these transfers so that monthly saving balances are always
positive.
Fix positive credit card balance
Too much cash has been paid into credit card account in one or more months.
Either reduce card payments or ignore message.
If you modify Cashflow Plan by inserting additional rows within key reports (as described in "Extending Cashflow Plan Home"
below) and fail to add full-year SUM formulae, Cashflow Plan will flag this by indicating an ERROR and numerous ######'s
will appear.

7. Extending Cashflow Plan Home
When men speak of the future, the Gods laugh (Chinese Proverb)

If familiar with spreadsheets, you can easily extend Cashflow Plan to include additional income or expenditure items or add
formulae. Before making changes, create a backup copy and, once changes have been made, test that they work as
intended by using large, easily identifiable assumption values.
Before making changes, you will need to use your spreadsheet to turn off each sheet's protection (via Review tab,
Unprotect Sheet if using Excel) and display its row/column headers (via Excel's View tab, Headings). By default
row/column headers are hidden for all sheets and can be turned on (once a sheet has been unprotected) via View tab,
Headings. The Formula Bar can be displayed via View tab, Formula Bar. With the Premium version, use options within the
*Protection and *Tools/Setup menus to speed up these tasks.
Here are some tips on extending Cashflow Plan:
1. Never delete unneeded rows. Instead, use your spreadsheet to hide them having first checked that they don't
contain values. Alternatively, your spreadsheet may support an equivalent to Excel's Group and Outline to
compact or explode the display of rows. Don't delete any of the worksheets supplied with Cashflow Plan as this
will damage its integrity.
Note: The Premium version of Cashflow Plan can be set via *Tools/Setup to automatically hide unused rows
when printing the main assumption and output reports.
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2. Insert an extra assumption row by injecting it into the middle of an existing block of assumption rows within the
"Incomes" and "Expend" sheets. This will ensure that it gets included in calculations. For example, in the
Household category within the "Expend" sheet, you could insert a new row between Appliances and Internal
maintenance/repairs . Be sure to add SUM and percentage formulae for the new row in the right most full-year
columns. Otherwise, ERROR will appear in adjacent cells and many other cells will show #######.
3. If you wish to add lots of extra assumption rows but don't want to clutter up a Cashflow Plan report, the easiest
solution is to use empty rows below the report to create a detailed table and then use simple cell references to
'plug' monthly totals into an appropriate unprotected, cream-coloured row within the report. If using the Premium
version, you MUST use Unlock Range within Cashflow Plan's *Protection menu to highlight these new assumption
values with blue font and cream background in order for them to be included in a monthly roll-forward.
4. You can use formulae to extend Cashflow Plan's assumptions. For example, you could use 3 rows below the
Expenditure Report for monthly vehicle mileage, monthly fuel consumption and monthly fuel price, and then insert
formulae in the Fuel row within the "Expend" sheet to calculate the monthly cost of fuel based on mileage etc. If
you are using the Premium version, you MUST use Unlock Range within Cashflow Plan's *Protection menu to
highlight these new assumption rows with blue font and cream background in order for them to be included in a
monthly roll-forward. Note that values within formulae, e.g. =100*F33, will not roll forward.
Be sure to back up your work regularly using an incrementing file name, for example, PLAN1, PLAN2, PLAN3 etc. in case of
an 'accident' or major error when making changes.

8. Improving Your Cashflow
Whoever has the gold makes all the rules (The Golden Rule)

Before embarking on a cashflow improvement programme, review and refine the results paying particular attention to larger
values and their timings. Watch out for duplicated or missed items. Adjust individual values as needed in order to arrive at a
"most likely" plan and, if appropriate, add some contingency values
Once projections have been finalised, the real planning work can commence. The projections will help you identify issues or
actions that might need to be pursued including:
Determining overall financial health and providing an early warning of possible problems and/or opportunities.
Smoothing out expenditure peaks by cancelling, postponing or scaling back purchases or by accelerating income.
Prioritising expenditure when making cut-backs.
Accumulating savings to cover seasonal expenditure peaks.
Determining the impact of inflation or taxation changes.
Maximising credit card purchases to avail of free credit.
Using funds on deposit or other savings to offset projected overdrafts or credit card borrowings.
Utilising projected cash surpuses to set up short- and/or long-term savings, investment or pension schemes.
Negotiating loan facilities or justifying salary increases.
To explore alternative scenarios, you can either use the 'what-if' facility or create separate Cashflow Plan files e.g.
BEST_SCENARIO.

9. Support for Cashflow Plan Home
Out of debt, out of danger (Proverb)

As the freeware version of Cashflow Plan is supplied 'as is' and without charge, PlanWare is not obliged to support users.
However, PlanWare welcomes feedback from users especially about non-Excel problems and maintains Frequently Asked
Questions at <www.planware.org/cashhome.htm>.
Purchasers of the Premuim version are supported for 30 days from date of purchase.
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10. Upgrading to Premium Version
Thinking is the hardest work there is, which is probably the reason why so few engage in it (Henry Ford)

If using Cashflow Plan frequently and having access to a desktop version of Microsoft Excel, you may consider switching to
the Premium version for its extra facilities and features. It can be purchased for US$12 (approximately €11 euro or £9
sterling) plus any sales or value-added taxes and downloaded for immediate use from <www.planware.org/cashhome.htm>.

11. About PlanWare
Luck is a dividend of sweat. The more you sweat, the luckier you get (Ray Kroc)

PlanWare is a well-established website owned by Invest-Tech Limited, an Irish-based management consultancy. Aside from
Cashflow Plan, we offer an extensive range of business tools for generating proforma financial projections, cashflow
forecasting, writing business plans, developing marketing and sales plans, and devising or reviewing strategic plans. Users
comprise startups, established businesses and professional advisers located in well over one hundred countries.
Our contact details are:
Address:
Website:
Product page:
Email:
Twitter:
Tel & Fax:

PlanWare, 27 Ardmeen Park, Blackrock, Co Dublin, Ireland
<www.planware.org>
<www.planware.org/cashhome.htm>
<info@planware.org>
@planwareorg
Tel: +353 1 283 4083
Fax: +353 1 288 7805
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